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Content of package

WidePIX CHROMATIC detector
+12 V DC adapter
2x quick coupling for water cooling (for 4x6 mm plastic hose)

USB memory stick with control software Pixet Pro

1. Start guide

Device Setup and Safety

1.

The device should be positioned securely to avoid falls or damage caused by contact with other
objects

Connect the device to the water-cooling system. Thermal stabilization to 22°C is strongly
recommended. Overheating can cause damage to the device.

Plug in the power adapter.

Connect the device to your computer via Ethernet STP cable (Cat6 or higher is highly
recommended) supporting speed of 1 Gb/s or higher.

LAN requirements

Connect the device directly to the network card or via a gigabit switch with no load on other
ports.

To fully utilize the dual-/triple-port WidePIX CHROMATIC, connect two or three dedicated
cables to two or three separate network cards in the computer. Each network card must
support speeds of at least 1 Gb/s.

If there is a slower or more complex network between the WidePIX and the computer, the
framerate may be limited, bad frames can occur, or some measurements may fail.

1x Ethernet cable for CHROMATIC 5 (Single Row), CHROMATIC 10 (Double Row)

2x Ethernet cables for CHROMATIC 10 (Single Row), CHROMATIC 20 (Double Row)

3x Ethernet cables for CHROMATIC 15 (Single Row), CHROMATIC 30 (Double Row)

Network Configuration and IP Addressing

1.

a.

1)

From factorial setting IP address is set 192.168.1.100 and Subnet mask 255.255.255.0 If more
segments IP addresses are 192.168.1.101, 192.168.1.102... (with the same subnet mask)

If the device was previously used and the IP was changed but is now unknown, device requires
the reset of IP address (see the IP address reset tutorial, below this section).

To ensure correct communication, modify the network settings on your PC.

Change network settings for Windows 11

(older Windows versions are very similar, see YouTube tutorial Network setting Windows 10)

Go to Start > Settings > Network & Internet > Ethernet



https://www.youtube.com/watch?v=gKqepY1Lb_c
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[l) Select the Ethernet connection used for the device

1) In IP assignment, click on Edit, see Figure 1: Network setting W1

Q, Find a setting

Network & internet > Ethernet

CS Ethernet 2 -
Not connected
Authentication settings Edit
Metered connection . of @ )
Some apps might work differently to reduce data usage when you're connected to this network

Set a data limit to help control data usage on this network

IP assignment: Automatic (DHCP) Edit
DNS server assignment.  Automatic (DHCP’ Edit
Manufacturer: lealtek Copy
Description: Realtek USB GbE Family Controller

Driver version: 1156.13.420.2023

Physical address (MAC):  D0:46:0C:FF:90:E1

Ethernet
CE '\I:uls:rul:-:g“- cted ~

Figure 1: Network setting W1
IV) Set Edit IP setting to Manual and then switch On IPv4, see Figure 2: Network setting W2

Edit IP settings

Manual

1Pv4
® ) off

IPve
® ) Off

Save Cancel

Figure 2: Network setting W2
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V) Additional settings will pop-up, fill up IP address and Subnet mask as shown below and click
on Save button. Note: last number of IP addresses should be different from IP addresses of
device. Example: If device IP is 192.168.1.100 you need to use different, for example
192.168.1.200, subnet mask is always 255.255.255.0 see bellow Figure 3: Network setting
w3

Edit IP settings

Manual w

1Pv4
@ o

IP address.

192.168.1.200

Subnet mask

255.255.255.0

Gateway

Preferred DNS

DNS over HTTPS

Off ~

Alternate DNS

Figure 3: Network setting W3

VI) Now you can connect to detector. Open your web browser and type IP address of device
192.168.1.100 (this is IP from factorial setting or after IP reset, if changed use new set one).
Page with ADVACAM interface should open in your browser. In bottom panel you can
update/change default IP address if needed. See Figure 4: Network setting W4

- o X

alo H

v [ Advacam Network Configuratic X+

« )

ANDVALCAM

Network Settings

Current Settings

Varsion
Serial Number

MAC Address
P Adaress
Subnot Mask
Gateway

IP Settings
Fixed IP Address
Fixed Subiet Mask
Fixed Gateway
Enable DHCP

Enable AutolP

30034
16721

TD3d5 et dc.nd
1921681100
266.265.256.0
19246844

w2 (16 [t [100
255 [255 255 0

192 168 1

Upaste

& Copyright 2022 ADVACAM.

Figure 4: Network setting W4
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b. Change network settings for macOS 13

See Network Setting for MacOS (second part of YouTube video tutorial)

) Go to Apple menu ® > System Settings, click Network (&) in the sidebar, click a network

service you want to edit, see Figure 5: Network setting M1.

[l) Click TCP/IP in the sidebar, edit Configure IPv4 to Manually, fill up IP address and Subnet mask
as shown below and click on OK button. Note: last number of IP addresses should be different
from IP addresses of device. Example: If device IP is 192.168.1.100 you need to use different,
for example 192.168.1.200, see Figure 6: Network setting M2.

[ll) Now you can connect to detector. Open your web browser and type IP address of device
192.168.1.100 (this is IP from factorial setting or after IP reset, if changed use new set one).
Page with ADVACAM interface should open in your browser. In bottom panel you can

update/change default IP address if needed.

L NON Network
Q ., USB 10/100/1000 LAN
" Self-assigned IP
Sign in
with your Apple ID =N Wi-Fi

-~

Connected

Software Update
Available

Wi-Fi
_B Bluetooth
Other Services
<

Thunderbolt Bridge
{3 Notifications €& e Not connected

Sound

Focus

8 Screen Time

Firewall
Inactive

iz General

@ Appearance
Accessibility

{5 Control Centre
© siri & spotlight
0 Privacy & Security

) E] Desktop & Dock

Figure 5: Network setting M1



https://www.youtube.com/watch?v=gKqepY1Lb_c
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WS¢ e Not connected Configure IPv4 Manually £
TCP/P IP address 192.168.1.200
Subnet mask 255.255.255.0
Router
Configure IPv6 Automatically ¢
Router Router
Cancel OK

Figure 6: Network setting M2

L] b~ < = 192.168.1.100 M+ B

NDVACAM

Network Settings

Current Settings
Version 3.10-3.21
Serial Number 16781
MAC Address 70-b3-d5-ef-dc-bd
IP Address 192.168.1.100
Subnet Mask 255.255.255.0
Gateway 192.168.1.1

IP Settings
Fixed IP Address 192 168 1 100
Fixed Subnet Mask 255 (255 256 0
Fixed Gateway 192 168 1 1
Enable DHCP
Enable AutolP

® Copyright 2022 ADVACAM.
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Figure 7: Network setting M3

c. Change network settings (for Linux)

[) Click on the network icon in the top-right corner of your screen (Wi-Fi or wired symbol).
Il) Select icon for Settings.

[l) Inthe Network settings window, pick your connection from the left sidebar. Click the gear icon
next to your active network.

IV) Go to the IPv4 tab. Change the Method from Automatic (DHCP) to Manual.

V) Enter your IP address 192.168.1.200, Netmask 255.255.255.0 Note: last number of IP
addresses should be different from IP addresses of device (use 2-254). Example: If device IP is
192.168.1.100 you need to use different, for example 192.168.1.200

V1) Click Apply.

VIl) Disconnect and reconnect to the network to apply changes.

IP address reset

*If there is more than one row segment, each segment requires its own Ethernet connection -> the

connections must be set up one by one.

1. If not connected, connect power supply. Connection to a cooling system is required for proper

operation of the device.
2. If connected, disconnect all Ethernet cables
3. Press and hold IP RESET button inside the hole for 10 s

4. |P address was set as default 192.168.1.100

IP reset

Figure 8: Illustrative picture with 1 Ethernet port for WidePIX CHOMATIC 5 (Single Row) or
CHOMATIC 10 (Double Row).
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2. Pixet Pro — GUI

Pixet Pro, developed by ADVACAM, is a desktop application for expert users that provides full control
of the Timepix- and Medipix-based detectors. It is used in manufacturing processes such as testing and
calibration, as well as in the development phase. The application is powerful, so inexperienced users
could set the device into a non-functioning state. Recovery is possible by loading the factory settings
shipped with the detector.

This section summarizes basic Pixet Pro settings. For more advanced information, refer to the Pixet
manual under the Help panel in Pixet — Advacam Wiki.

Here you can find summary and basic setting for Pixet, for advance information see Pixet manual under
Help panel in Pixet.

Installation
1. Install the Pixet application from attached USB memory stick or from ADVACAM website:

- Pixet for Windows is distributed as a single executable file for automatic installation. Run
setup.exe and follow the instructions it the setup wizard.

o Pixet for macOS system is distributed as a standard .dmg file. After mounting the pixet.dmg
file a window with disk content will open. To install, move the Pixet file to the Application
folder.

o Pixet for Linux system is distributed as a single .tar file. To install, untar the file at a required
location. The application is launched by executing the pixet.sh script.

2. Run Pixet application. A table with available devices will pop up, see Figure 9. Choose your
device. If device has more column segments like CHROMATIC 10 (Doble row) and higher, you
need to choose all segments and click on OK.

A Avzilable Devices - PlXet X
Please select device(s) you want to use:
Device IP Address Already Opened
WidePIX MPX3 L sn: 317 192.168.1.100 No
O WidePIX MPX3 L =n: 318 192.168.1.101 No
Select All Select Mone Refresh ‘ Cancel OK

Figure 9: Available devices



https://wiki.advacam.cz/wiki/PIXet
https://advacam.com/downloads/
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3. The Pixet program will open. The device ID icon appears in the left panel.
4. Ifitis first time connected to your computer or to new one, error message will appear and
Config. file needs to be loaded.

X Pixet 1,84 Build 55ch1927 (250831) - WideP[X C06-W0562-5 sn 317 - PlXet = [m] >
File View Panels Tools Help
H BHECE Q== 0 A o B License: Advacam X,
1 =
C06-W0562-5 ¥ Image Properties
Min: 0 Max: 1
L]
I:I Auto range: Min-hax v
Type: Count: Time [s]:
Frames ~ 10 A~~~ 04
I:I Repeat I:I File output e
0 PR
&) stert

0 X (column number) 1279

L g v Detector Settings
0 0.25 0.5 0.75 1
Rel. THL 0: Rel. THL 1: Bias [V]:

0.0 A~ 00 w5

Mode:

SPM 1CH v () 24bit &
() Apply Filter

Flat-Field

Messages

Open when new message

(16:37:13.421) Ne configuration for the device found. Please load the configuration from factory directory or from installation media.

I Messages €l DAC Panel FPS:0 | T:0:00:000 |R:0/0 A0/0 | ©
Figure 10: Example of new device connected before Config file was loaded. In Detector setting

section THL are without units and values are set to zero. Also, Error message occurred.

5. To Load configuration: File > Load config. > find config file on attached USB driver, it is .xml file
named same as ID of the device (in this show example - WidePIX-C06-W0562-5.xml)

A Pixet 1.8.4 Build 55cb1927 (250831) - WidePIX C06-W0562-5 sn 317 - PlXet - a X
1
File I View Panels Tools Help
| .
Open Frame... E = 0 A 0 B License: Advacam X
Load Config.. I Min: 0 Max: 1
Save Config.. . .
Load Factory Config \:\ Auto range: Min-Max hd
Reconnect Ctrl+Shift+R
Save Pixet Config Type: Count; Time [s]:
Frames v 100 A~ 0
\:\ Repeat I:I File cutput wr

Figure 11: Configuration file - loading
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6. Configuration file contains default settings of the detector including calibration of energy
thresholds to keV. Settings of thresholds in keV and bias voltage are shown in the Detector
Settings panel when the configuration is properly loaded. The device is now ready for use.
However, it is advisable not to start any measurements until the thermal equilibrium is
established (~ 5 minutes). For CdTe sensors, it is advisable to expose the detector to X-rays for
a few minutes prior to measurement.

7. Last settings are stored locally upon closing Pixet and reloaded the next time the same device
is used. Defaults can be restored any time by loading the default configuration.

A Pixet 1.8.4 Build 55cb1927 (250831) - WidePIX CO6-W0562-5 sn 317 - PlXet = [m] *
File View Panels Tools Help
m Ea BEEHE Q= = 0 A 0 B License: Advacam X
(=
CO5-W0562-5 ¥ Image Properties
Min: 0 Max: 1
. .
I:I Auto range: Min-Max v
Type: Count: Time [s]:
Frames v 100 A~~~ 01
I:I Repeat I:I File cutput %ar
0 A
@® start
0 X (column number) 1279

0 0.25 0.5 0.75 1
THL O [keV]: THL 1 [keV]: Bias [V]:
80 10.1 A
Mode: 36V
SPM 1 CH ~ [_) 24 bit K
I:I Apply Filter
Flat-Field v @ Q@

4

(16:37:13.421) No configuration for the device found. Please load the configuration from factory directory or from installation media.

Open when new message

Messagesm DAC Panel FPS:0 | T:0:00:00.0 R:0/0 | A:0/0

Figure 12: Example after loading Config file. In Detector setting section THL shows units and
values from calibration are set. Also, bias voltage is set. (for CdTe, polarity should be set
negative but show positive value under).

10
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Main tool bar

A Pixet 1.8.4 Build 55cb1927 (250831) - WidePIX C06-W0562-5 sn 317 - PlXet = O X
File View Panels Tools Help
Ee BEEHE Q== 0 A € B[] License: Advacam X

Figure 13: The icons in the toolbar are described below from the left side to the right side.

Open Frame: Opens and loads measured data from hard disk into the

software. The frames can also be opened by dragging and dropping frames
on to the frame panel.

d Save data: Saves all the measured data (frames) from memory to a hard

drive. Users can choose between several file formats to save the frames.

Show grid: Shows grid over the frame that highlights borders between

EEH
pixels of the frame.
Show chip ID number
P Rotate clockwise: Rotates the frame clockwise by 0, 90, 180 or 270

degrees.

Q Color map: In the Color map dropdown box it is possible to select colors

that are used to map values of the frame.

Under warning, Over warning: These two buttons set if the values under

the selected range or over the selected range should be highlighted with
special color. You can set the range using the Min and Max fields in the
Image Properties panel on the right side. For the gray map there are green
color (under values) and red color (over values)

Shows the frame with selected index. By clicking on arrows previous or

b’
&

next frame could be shown. Only work with Frame type.

If enabled every new measured frame is automatically shown in the frame

panel. When not enabled, the frames are measured in the memory but are

not shown in the frame panel. To accelerate the measuring of frames from
the device, it is recommended to disable this option.

Shows the pixel configuration toolbar and pixel configuration frames (Mask

bits, Test bits, ...) Measurements: Measurement utilities.

Runs the integrated Python console. Program can control the Pixet

program and use graphic features.

11
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Understanding the Medipix3 chip operation - WidePIX CHROMATIC

Comparison of Medipix and Timepix chips

« Timepix-based detectors allow both the photon counting and spectroscopic “time-over-threshold”
measurement. Medipix-based detectors operate only in the photon counting mode. However, the
radiation spectra can be measured using a threshold scan.

« Timepix-based detectors have single energy threshold. All energies below the set value are cut
off. Devices are set to a minimal threshold above noise by default. This is typically 5 keV. The
threshold can be adjusted by user in the counting mode.

o Medipix3 detectors have one or more adjustable energy thresholds. The number of thresholds
varies according to the sensor pixel pitch and the mode of operation. The logic is the same as for
Timepix-based detectors; all available thresholds cut off lower radiation energies. Minimum
threshold is typically higher compared to Timepix-based devices and depends on additional
settings.

« Unlike the Timepix-based detectors, the Medipix3 offers several operation modes for the counting
measurement. The list of modes is described in the following section.

Overview of Medipix3 read-out chip operation

Each pixel of the Medipix3 (MPX3) chip has two thresholds and two 12-bit counters, which can be
alternatively merged with one 24-bit counter, providing enhanced dynamic range.

In principle, two main modes of operation are available:

1. Single Pixel Mode (SPM): every pixel works independently of its neighbors, analogous to
Timepix-based devices.

2. Charge Summing Mode (CSM): two thresholds are used for energy discrimination. The
algorithm is as follows: the detected quantum of radiation generates an electric charge in the
sensor. The charge is typically collected to two or more pixels and creates an electric signal in
each pixel. The signal is compared to the first threshold in every pixel. Signals below the
threshold are cut off (similar to the SPM). The signal/charge of 4 neighboring pixels is
reconstructed (summed) and assigned to the pixel with the largest charge deposition. The result
is then compared to the second threshold, signals below the threshold are omitted.

The CSM suppresses the effect of charge sharing and the images are sharper in comparison to the SPM.

Both modes can be moreover operated in several ranges which define the minimal and maximal
achievable threshold. Selection of the range affects also further properties, such as the energy resolution
and stability (noise) of the detector. The range setting can be found in literature under the term “gain
mode”.

12
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More details in section: 3. Practical examples of measurements
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Mode of operation can be selected via drop-down list in the Detector Settings panel:

SPM 1 CH (Single Pixel Mode - one channel) One counter is in use. One energy threshold (energy
channel) is available. Output: one 12-bit or 24-bit image representing the number of events per pixel.

¥ Detector Settings

THL O [keV]: THL 1 [keV]: Bias [V]:
8.0 ~ v 101 A v -350

Mode: 34TV 264 uh
SPM 1 CH v () 24 bit x

SPM 2 CH (Single Pixel Mode - two channels) Two counters are in use. Two energy thresholds

(energy channels) are available. Output: two 12-bit images representing the number of events per pixel.

¥ Detector Settings

THL 0 [keV]: THL 1 [keV]: Bias [V]:
8.0 A~ 101 A~ 2350

Mode: 347V 252 uA
SPM 2 CH v () Py

CSM (Charge Summing Mode) Two energy thresholds are in use. Output: one 12-bit or 24-bit image

representing the number of events per pixel. For more information see tutorial How to use CSM.

¥ Detector Settings

THL O [keV]: THL 1 [keV]: Bias [V]:
a.0 A~ 100 A~ w2350

Made: M7V 257 vA
CSM v () 24 bit A

After changing the operation mode, values of the energy thresholds may change according to the
respective energy calibration.

Counter depth is set to 12 bits by default. Check the checkbox in Detector Settings panel for 24-bit

depth.

13

* Detector Settings

THL 0 [keV]: THL 1 [keV]: Bias [V]:
8.0 A 10 A~ 2350

Mode: 34TV 16.6 uA
SPM 1 CH ~ @ 24 bit P



https://www.youtube.com/watch?v=5EXauR3pMZ8&list=PLvvnHbTf8rFaYFbFl_4PZTikJm3Pk5E2f&index=14

WidePIX CHROMATIC manual D IAVAVANE BAN Y |

Imaging the Unseen

Setting the range - advanced A

Click on the More Detector Settings button in the Detector Settings panel. New window will appear.
Select the range in the drop-down list within the Settings section of the first Detector tab:

« Broad - the largest threshold range.
« Narrow - better energy resolution at lower energies.

« Super Narrow - very limited threshold range, the best energy resolution at lower energies, better
signal-to-noise ratio

Click OK to confirm the changes.

By default, the detector will be calibrated for the Narrow gain mode. Additional gain modes can be

added upon request. Broad range and combination of Super narrow mode with CSM is not available
with silicon detectors.

A More Detector Settings - PlXet x
Detector Chip Layout
- Information
Full Mame: WidePIX COB-WO0562-5
Device Serial: 317
Chip Type: Medipix3 RX
Calibration: Mo
Parallel Readout: Mo
- Settings
Range (Gain mode): Marrow (HGM) o
O | Marrow (HGM)
Broad (SLGM)
~Custom Settings Super Narrow (SHGM) k
Counter: Counter @ ~
| Counter Depth: 24 bits v
Colum Block: All ~
Row Block: All v
Disc C5M SPM: Disc 0 ~
[I Cancel

Figure 14: More detector settings

Note: More Detector Settings section is intended for expert users only. Any modification of Custom
Settings section may lead to unpredictable behavior of the device!

14
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Useful tips and how-tos

Here are several tips for more effective and comfortable use:

Composition of panels on the right side of the Pixet window can be configured in Panels in menu bar.
Orientation of the image (rotation, mirroring) can be customized in View drop-down list in menu bar.
To keep the aspect ratio of the image, click on View > Ensure Aspect Ratio in menu bar.

Default colormap is gray. Colormap can be selected via drop-down list under the Multicolored icon
located in main toolbar.

Image Properties panel allows you to adjust brightness and contrast of the displayed images by
setting the range to be displayed. Auto range option provides automatic adjustment.

Advanced Image Properties panel allows to set gamma correction for better visibility of features
within measured sample.

Pixet allows opening and showing previously saved images by drag and drop into image area of the
Pixet window. When multiple images are dragged and dropped, one can browse them using blue
arrows in the main toolbar.

Images can be zoomed by holding the left mouse button in the frame, dragging the mouse to create
a selection rectangle and releasing the mouse button. To restore the original frame size, double click
on the image.

Application output including error messages are shown in Messages panel.
In case of hardware disconnection, the device can be reconnected by clicking File > Reconnect in
menu bar without restarting Pixet application.

X Pixet 1.8.4 Build 53cb1927 (250831) - WidePIX C06-W0362-5 sn 317 - PlXet - [m] X
File View Panels Tools Help
B W BEEC¢ Q=x= 0 ~ve B B License: Advacam X
—

(C06-W0562-5 ~ Image Properties

Min: 0 Max: 1

(C) Autorange:~ Min-Max ~

¥ Measurement

Type: Count: Time [s):
= Frames ~ 100 A 01
¥ O Repeat () File output &
0 v
0
£ X (column number) 1279 ® s
0 025 05 o75 1'
THLO [keV]: THL 1 TeeVl: Bias [V]:
& Av 01~ 350
Mode: 347V 166 uA
SPM 1 CH ~ @ 24bit K
‘:' Apply Filter
Flat-Field v @ 0 0

Messages

: 4 Open when new message
) Cannot perform operation - device is busy or locked.

ounter Depth failed ()
-5: Cannot

s (Cannot send data (re=-11),, re=-103)
s (chan. ip=0): C
chan=0, chi
DACs (Cannot
-5: Cannot set DACs (chan=0, chi
failed (Cannot set DACs (chan=0, chip=0)

annot send dat;

data (re=-11),, re=-103]
annot send data (rc:
annat send data (rc=-11))

B0 Messages WY DAC Panel FPS:0 | T: 0:00:000  R:O/0 A0/ ©

Figure 15: Message panel with Error messages.
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WidePIX CHROMATIC - Synchronization guide
For proper connecting dual- or triple-port WidePIX CHROMATIC

1. Run Pixet, select your device and all its segments, and click OK

'Y

Please select device(s) you want to use:

Device IP Address Already Opened
WidePIX MPX3 Lsn: 317 192.168.1.100 No
WidePIX MPX3 Lsn: 318 192.168.1.101 No

Figure 16: Choosing 2 segments of WidePIX CHROMATIC 10 Single row
2. Device IDs should appear in the left panel, one per segment.
3. Load the configuration for each segment if not already done.
4. Each device has one Master segment and others are called Slaves. If Config. are loaded
properly you can recognize Master as one where you can Edit Bias voltage, for Slaves it
shows 0O and it cannot be edited.

Note: The bias source is connected to the master segment.

A Pixet 1.8.4 Build 55ch1927 (250831) - WidePIX B04-W0586-5 sn 318 - PiXet

|
[m]
X

File View Panels Tools Help

0 B License: Advacam [ X,

~ Image Properties

IR}

Min: 0 Max: 1

EO04-WO586-5 .

() Auto range: Min-Max v

~ Measurement

Type: Count: Time [sk
Frames ~ 100~~~ 01

() Repesat () File sutput

0 o

@ Start

~ Detector Settings

THLO [keVE: THL 1 [keV: Bias [V]:
&0 el ;
Mode:

X (column number) 1219 SPMI1CH ~ () 24wit

.
0 0.25 05 0.75 p—
() Apply Filter

Flat-Field ~ @30 e

Pixel Count:

FPS:0 | T: 0:00:000 | R:0/0 A0/  ©

Figure 17: Example of connected device with two segments.
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5. All segments need to be set separately. Type, Count, Time should be set on same value for
all.

a. On Master segment, click the gear icon (more Measurement settings) in Measurement
panel. Set values in Trigger setting (see below)

I) Started by HW Trigger
II) Wait for ready — YES
lll) Master —YES

IV) Out Level —log 1

V) Stg-log 0

b. On Slave segment, click the gear icon (more Measurement settings) in Measurement
panel. Set values in Trigger setting (see below)

[) Started by HW Trigger
Il) Wait for ready — No

lll) Master — No

IV) Out Level —log O

V) Stg —rising edge

A Measurement Settings - PlXet x A Measurement Settings - PlXet X

General File Qutput General File Qutput
-Advance Measurement Settings -Advance Measurement Settings

Delay after repeat [s]: 0.000 ~ Delay after repeat [s]: 0.000 o

Spacing: 1 ~ Spacing: 1 ~o

[:I Refresh DACs before measurement [:I Refresh DACs before measurement

CI Refresh Pixel Cfg, before measurement [:I Refresh Pixel Cfg, before measurement

[:I Time Delayed Integration (TDI) D Tirne Delayed Integration (TDI)
- Trigger Settings - Trigger Settings

Started by HW Trigger v HW Tngge ~

Wait For Ready Yes Wait For Ready [:I MNo

Master Yes Master [:I MNo

Out Level log 1 N Out Level log 0 4

Stg log 0 N Stg rising edge
~Test Pulses Settings ~-Test Pulses Setting ‘
Pulse count (1 -0) 0 O Pulse count (1 - 0) 0 e

Pulse period (1 - 0) [us] 0.00 O Pulse period (1 - 0) [us] 0.00 O ‘
Pulse Charge1 (0 - 0) [V] 0.00 A Pulse Charge1 (0 - 0) [V] 0.00 '

Pulse Charge2 (0 - 0) [V] 0.00 A Pulse Charge2 (0 - 0) [V] 0.00 '

() Manual TP Bits ) Manual TP Bits

QK Cancel QK Cancel

Master device Slave device

17
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6. Now device is ready for acquisition

C A

g the U

D RAVAAN
a

7. Start acquisition of Slave device - the device will wait for the master's trigger.

8. Start acquisition of Master device - both devices start the acquisition simultaneously.

Note: For easy operation you can separate each window segment by Undock option in right upper corner

X Pixet 1.84 Build 55cb1927 (250831) - WicePIX CO6-W0562-5 sn 317 - PlXet = o X X Pixet 1.84 Build 53cb1927 (250831) - WidePIX BO4-
File  View  Panels  Tools  Help
Ebkd BEEE Q== 0 A~ 0 B license: Advacam X |E bl BEE Q= = 0 A~ R (B[] License: Advacai !
—
CO6-W0S62-5 ¥ Image Properties ~ Image Properties
Min: 0 Max: 1 Min: 0 Max: 1
. . . .
() Autorange:  Min-Max v (D) Autorange:  Min-Max ~
[ Mesaremen ]
Type: Count: Time [s}: Type: Count: Time [s]:
Frames v 100~ 01 Fames v 100~ 01
(O Repeat () File output @ (O Repeat () File output @
0 o~ ] AV
& st @® start
THL O [keV]: THL 1 [keV]: Bias [V]: il THL O [keV]: THL 1 keV: Bias [VI:
]
A~ 102 A~ 35 80 ~~ 100 =
e e ce 0 X fcolumn numben) 1279
0 X {column number) 1279 Mode: 347V 4T8uA I, Ve
SPM 1 CH ~ () 24bit 0 025 05 075 1 SPMICH ~ (D a4bit
0 025 05 075 1 "' ! & — &
() Apply Fiter () Apply Filter
Flat-Field v i@ 0 e Flat-Ficld v a0
XYE: [ XY -1
Count 0 Count: 0
Min 0 Min: 0
Max 0 Max: 0
Pixel Count: 0 Pixel Count: 0
~ Histogram

!
FPS:0 T:0:00:000 R:O/0 AQ0 =

[ viessages JE DAC Panel

PR Miessages ] DAC Panel

FPS:0 T:0:00:000 R:O/0 AQ0 =

Figure 18: Pixet with separate windows for each segment.
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3. Practical examples of measurements

Measurement in SPM 1 CH - using one threshold

Set the device to SPM 1 CH operation.
Switch on / off the 24-bit counter depth (optional).

Set first threshold (if needed) THL 0 [keV] to desired value (It is not recommended to use lower value
than shown after Loading Config file). Second threshold THL 1 [keV] is not in use for this operation
mode.

Note: If [keV] is not shown, Config. file was not loaded.

THL 0 [keV]: THL 1 [keV]: Bias [V]:
8.0 A 0 ~ov 2350

Mode; 3TV 264 uh
SPM 1 CH v () 24 bit b

Figure 19: Detector setting for SPM1

Controlling the measurement parameters via Measurement panel
Select type of measurement in Type drop-down list. There are two options:
For single acquisition select Frames and set parameter Count to 1.

Integral — several acquisitions are added to one frame. Number of acquisitions to be added is defined
by parameter Count.

Set the exposure time of individual frame acquisitions in seconds using Time [s].

Checking the Repeat checkbox and setting the number of repetitions using the text box underneath will
cause repeating the defined measurement several times. Setting the number of repetitions to zero value
means “repeat forever”. If the Repeat checkbox is unchecked, the number of repetitions is not in use.

* Measurement

Type: Time [s]:

Frames 0.1

Count:

~ 1 AN

|:| Repeat |:| File cutput

R

0 ~

@ Start

Figure 20: Measurement panel

Note: In case of combining Repeat and Frames, it is advisable to set the Count parameter to value
greater than 1, especially for acquisition times shorter than 1 s. This prevents unwanted increase of
dead time measurement.
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Starting the measurement

Start / stop the measurement using Start / Stop button on the Measurement panel. Progress of the
measurement is shown in the status bar at the bottom of the window.

Once the measurement is finished, the measured frame is shown in the image preview area of the Pixet
window.

Automatic saving of measured data

Check File output in Measurement panel for automatic saving. Then click on the button with three dots.
A system dialog window will appear to Select the target destination and filename. Confirm by clicking
the Save button. Measured data are saved automatically during the measurement. A warning dialog
will appear if the file name and destination is used for another measurement.

¥* Measurement

Type: Count: Tirne [s]:

Frames w o A~ 01

() Repeat File output é5
0 Ao AWidePi CH_10_sr\test tut

@ Start

Figure 21: Automatic saving example.
Two files are saved by default to each frame:
. data file (.txt)

o Description file (.dsc) which contains information about the device, used configuration,
measurement settings, etc.

For detailed Saving option, see YouTube tutorial Data saving and Data format

Manual saving of measured data

Click on File > Save Data option in menu bar or Saving icon or Ctrl + S. A system dialog window wiill
appear. Select what you want to save, see Figure 22.

Save raw data option will save last set of measurements. Save Current Frame option will save current
frame from screen with applied filters. Option Save All Frames is similar to the Save raw Data in this
case.

Select the target destination and filename and confirm by clicking the Save button.
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X Save Data - PlXet X

-Save Data

O Save raw data to frames or other format

O Save the currently visible frame as shown on screen with
selected image range, applied calibraticn or filters te file (frame, image, ..)

O Save all measured frames frem memery to frame or image files with
selected image range, applied calibration or filters.

| QK Cancel

Figure 22: Saving options

Measurement in SPM 2 CH - using two thresholds
« Set the device to SPM 2 CH operation mode as described above.

o 24-Dbit counter depth is not available.

e Set both thresholds THL O [keV], THL 1 [keV] to desired values. Second threshold should be
higher than the first threshold. It is not recommended to use lower value than shown after Loading

Config file.
THL O [keV]: THL 1 [keV]: Bias [V]:
2.0 Ao 702 Ao =350
Mode:
ssM2cH  ~ () A

Figure 23: Detector setting for SPM2. THL 1 should be higher than THL O

Controlling and starting the measurement is same as in example for SPM 1.

Once the measurement is finished, the measured frames are shown in the image preview area of the
Pixet window. Use buttons at the below image to switch between the energy channels.

Saving measurement is similar e as in example for SPM 1. Four files are saved by default:
« data file (.txt) for first channel with ending “_THLO"

« description file (.dsc) for first channel with ending “_THLO”

« data file (.txt) for second channel with ending “_THL1"

« description file (.dsc) for second channel with ending “_THL1"
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Measurement in CSM

« Set the device to CSM operation mode as described above.
«  Switch on/ off the 24-bit counter depth as described above (optional).

« Set both thresholds THL 0 [keV], THL 1 [keV] to desired values. Second threshold should be
higher than first threshold.

¥ Detector Settings

THL 0 [keV]: THL 1 [keV]: Bias [V]:
8.0 A 100 A 2350

Mode: 3TV 251 uA
C5M ~ ) 24 bit x

Figure 24: Detector setting for CSM

Controlling and starting the measurement is same as in example for SPM 1.

Measurement in Time Delay Integration regime

Time delay integration (TDI) is implemented for WidePIX CHROMATIC Single row devices only. TDI
can be used for continuous scanning where, for example, samples move on a conveyor belt along the
detector.

To switch on / off this functionality click on More Measurement Settings button in the Measurement
panel. New window will appear. Then check / uncheck Time Delayed Integration (TDI) checkbox in
the Advanced Measurement Settings section on the first tab General. Confirm the change by clicking
OK.

All operation modes, bit depths and ranges of static measurement (as described in previous section) are
implemented also in TDL.

Alignment of the experiment

Sample measurement has to move along with the detector. Movement of the sample with respect to the
WidePIX device must be in the sense from the top to the image bottom (i.e. towards the device readout
peripheries; by default, the image in Pixet is oriented with peripheries at the bottom).

Set the operation mode, counter depth and energy threshold(s) as desired. Switch on the TDI regime
as described above.

Measurement panel

« Set the Type of measurement to Frames.

« Set number of frames into Count.

. Enable repeating and set number of Repeats.

« Set acquisition time Time [s] corresponding to the movement of the sample by chip size (dead time
for the chip read-out should be included). The chip size is 256 x 0,055 = 14,08 mm. Hence, the
exposure time corresponds to the speed the sample moves along this distance. To achieve perfect
synchronization time can be optimized by evaluation of object sharpness.
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4. Advanced control using Python Scripting plugin -*

The Pixet GUI has Python Scripting. This plugin allows the user to perform complex measurements
controlling the detectors automatically via Python commands and scripts. Click on the Python Scripting
icon on the right edge of the main toolbar to start the Python Scripting plugin. A new window with
simple editor will open. The window contains a python console, where python commands can be run

one by one with immediate output. The console also contains the output of executed python script.

The Python Scripting embeds a full python 3.12 (for Pixet Pro 1.8.4 and older, python 3.7.x was used)
interpreter including the standard python libraries. All standard functionality of python is therefore
accessible. Please refer to www.python.org or www.learnpython.org for more information about Python

programming language. List of functions can be found also in the main panel of the Python Scripting

window Help > Function List...

X Python Scripting - PlXet = O X W
File Edit Script Help
OE A P L]

Untitled.py [E]
1

Welcome

Figure 25: Python scripting window.

The Pixet API (Application Programming Interface) is accessible in the scripts via a pixet variable. This
variable represents the IPixet object that provides all the necessary methods to get information about
all connected devices, log messages to log file, access the Pixet menu, etc. A list of all available objects,
methods and constants of the Pixet API can be found on Python API.
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Sample script #1

Detector settings (operation mode, counter depth, range, threshold), simple acquisition

# get list of all connected Medipix3 devices
devices = pixet.devicesByType(pixet.PX_DEVTYPE_MPX3)

# get first device from Llist
dev = devices[0] # returns IDevMpx3 object

# set operation mode
dev.setOperationMode (pixet. PX_MPX3_OPM_SPM_1CH)
# SPM 1 CH: pixet. PX_MPX3_OPM_SPM_1CH (0)

# SPM 2 CH: pixet. PX_MPX3_OPM_SPM_2CH (1)

# CSM: pixet.PX_MPX3_OPM_CSM (2)

# get operation mode

print('Operation mode: ' + str(dev.operationMode()))

# set counter depth
dev.setCounterDepth(pixet.PX_MPX3_CNTD_24B)
# 12 bits: pixet. PX_MPX3_CNTD_12B (2)

# 24 bits: pixet. PX_LMPX3_CNTD_24B (3)

# get counter depth
print('Counter depth: ' + str(dev.counterDepth()))

# set range

dev.setGain(pixet. PX_MPX3_GAIN_SUPERHIGH)

#  Super Narrow: pixet.PX_MPX3_GAIN_SUPERHIGH (0)
#  Narrow: pixet. PX_MPX3_GAIN_HIGH (1)

# Broad: pixet. PX_MPX3_GAIN_SUPERLOW (3)

# set threshold

th_index = pixet.PX_MPX3_THO # index of threshold to be changed

# THL O: pixet.PX_MPX3_THO (0)

# THL 1: pixet.PX_MPX3_TH1 (1)

chip=4 # chip index (chips are counted from 0!, choose Chip number - 1)
# chip #1: O

# chip #5: 4

# all chips: pixet. PX_CHIP_ALL (-1)
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th_energy = 30 # new value of threshold in keV
dev.setThreshold(chip, th_index, th_energy, pixet. PX_THLFLG_ENERGY)

# acquisition

acqCount =1 # number of acquisitions

acqTime = 10 # time of acquisition in seconds
dev.doSimpleAcquisition(acqgCount, acqTime, pixet. PX_FTYPE_NONE, ")

# get last acquired image
frame = dev.lastAcqFrameRefInc()
data = frame.data()

Sample script #2

Integral acquisition, saving the data

# get first device from list of all connected Medipix3 devices
dev = pixet.devicesByType(pixet. PX_DEVTYPE_MPX3)[0]

# set operation mode
dev.setOperationMode (pixet.PX_MPX3_OPM_SPM_2CH)

# set acquisition parameters

acqCount = 10 # number of acquisitions for integral measurement
acqTime =0.1 # time of one acquisition

fileName = "./test/image.txt'

# integral acquisition, saving
dev.doSimplelntegralAcquisition(acgCount, acqTime, pixet.PX_FTYPE_AUTODETECT, fileName) # data are
automatically saved
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Sample script #3

Threshold scan

# get first device from list of all connected Medipix3 devices
dev = pixet.devicesByType(pixet.PX_DEVTYPE_MPX3)[0]

# set operation mode
dev.setOperationMode (pixet.PX_MPX3_OPM_CSM)

# set acquisition parameters

th = pixet.PX_MPX3_TH1 # index of threshold to be changed
ths = range(10,45,5) # thresholds in keV

acgCounts = [1 for number in ths]

acqTimes = [0.1 for number in ths]

output ="./test_' # destination path

# threshold scan
for i in range(len(ths)):
print('TH: {}' format(thsli]))
dev.setThreshold(pixet.PX_CHIP_ALL, th, ths]i], pixet. PX_THLFLG_ENERGY)

fileName = output + str(ths[i]).zfill(3) + 'keV.txt'

dev.doSimplelntegralAcquisition(acqgCountsJi], acqTimesli], pixet. PX_FTYPE_AUTODETECT, fileName)
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